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•

1.
2.
3.

1.
2.

1 POS SDK. Introduction

On this page:

Purpose of the Guide
Structure of the Guide
General information 
about POS SDK

1.1 Purpose of the Guide
POS SDK utilities and libraries package document is a property of the AxxonSoft company. This document is a 
reference manual for developers of POS PSIM software.

This document contains information about POS SDK utilities and libraries package designed for configuring 
operation of POS PSIM with POS terminals of different manufacturers.

1.2 Structure of the Guide
This document includes the following:

Description of the XML protocol.
Information about parsers usage.
Description of external libraries for working with POS PSIM.

1.3 General information about POS SDK
POS SDK utilities and libraries package is available for loading on the page.

Utilities package in POS SDK allows creating of parsers to get information from POS receipts and input this 
information to a receipts database.

Database is loaded in one of the following ways depending on communication protocol of receipt data from POS-
terminal to POS-server:

Using the xml_titles.txt parser.
Using parser with .prl resolution.

Libraries package is designed for sending data to POS PSIM from external programs.

Note

Detailed information about parsers configuring in POS PSIM is given in the POS PSIM. Administrator's 
Guide document.



Attention!

Libraries of the POS SDK are applied for example. AxxonSoft company is not responsible for their 
operation.



https://docs.axxonsoft.com/confluence/display/posPSIM100en/Administrator%27s+Guide
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1.
2.

2 XML-protocol

2.1 Description of XML protocol

2.1.1 General information about XML protocol
XML protocol allows adding connectivity with POS PSIM operation control system to POS software developers if 
data of POS operations is sent as XML packages. This format allows transferring any number of significant 
parameters to a system and organizing their displaying on a video image and saving in a transaction database.

XML package has the <TransactionBlock> basic tag. Separate xml package is sent to Axxon PSIM for each POS 
operation. Each package should have the <TransactionBlock> start tag and the </TransactionBlock> end tag. So 
each POS operation has its presentation as XML package. Example of sent package is shown in the figure.

All parameters are presented as a text. It's possible to use a period or a comma to separate a fractional part of a 
number. Converting to the required type is performed automatically.

POS program should send data to TCP, UDP or RS232 port (specified in the settings). Separate port is used for each 
POS.

When the TCP protocol is used, it's required to foresee an automatic connection recovery in case of connection loss.

Required tags of xml-package:

FunctionNumber—number of a function.
TransactionTimestamp (conditionally required tag)—event time specified in the yyyy-mm-ddThh:nn:ss.fff
format. It is specified in the UTC+0 time zone. If the TransactionTimestamp tag is missing in the package, 
the time of the package receipt is written to the database instead of event time.
The following symbols are used:
yyyy—year as four-digit number.
mm—month, in the range from 01 to 12.
dd—day of the month, in the range from 01 to 31.
hh—hour in 24-hours format from 00 to 23.
nn—minutes, in the range from 00 to 59.
ss—seconds, in the range from 00 to 59.
fff—thousandths of a second (millisecond) in date and time values.

The element of the XML package must be separated by line separators (consecutive 0xD, 0xA characters). It's more 
convenient to do when debugging the system (when using the xml_test.exe utility, see Configuring xml_titles.txt 
settings file).

The total number of parameters is not limited. Parameter names must not contain spaces. Received data are 
displayed on the screen as captions and recorded to a database for further analysis.

The Axxon PSIM\Modules\Pos\xml_titles.txt file is used for settings (see Format of xml_titles.xml settings file).
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All received data are recorded to the POS_LOG_MASTER and POS_LOG_DETAIL tables.

The default name of the receipts database is pos, MS SQL Server 2008 is used.

2.1.2 Control package
If there is no any pos activity, but connection with POS PSIM is established, it's required to send control package 
confirming TCP/IP connection. Recommended interval is 30 seconds. Control package is sending with the 
FunctionNumber=77777 parameter.

Time of data reading in seconds is specified on the site of POS server. System considers that connection with 
software is lost if none of XML packages was not received during the specified time. In this case connection is 
closing and establishing again.

2.1.3 Format of xml_titles.xml settings file
Sample view of xml_titles.txt file is shown in the figure.
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1.

The numbers in square brackets represent the numbers of functions that come in the FunctionNumber field of the 
package. Directly below the number the template is specified in brackets — a description of how the specified 
function will be displayed on the video image. The variables in angle brackets "<>" will be replaced with the 
corresponding values. If there is at least one such parameter in the string, and there is the data incoming from the 
POS terminal with this parameter missing, then the entire string will be ignored and will not be displayed on the 
screen.

It's possible to specify single functions (e.g. [1] or [2]) and combination of several functions if they have the same 
template (e.g. [1,2,5,10]).

Configuring of file sections and fields is follows:

Parameters of fields formatting are specified in the [PARAM_TEXT_FORMAT] section.

In example the ItemName parameter is displayed. Its maximal length is 25 symbols (spaces will be added 
automatically if length is less), left alignment, all symbols are displayed in capitals.



POS PSIM 1.0.1 (english) – POS SDK

XML-protocol– 9

2.

3.

4.

5.

6.

7.

8.

9.

Available alignment values: left, right, center.
Available values of letters size: upper, lower.
Numbers of sections corresponding to new receipt entry are specified in the [PROLOG] section. Function, 
number of which is specified in this field, automatically increases (per one) internal counter of receipts 
(transactions). Parameters corresponding to these functions should be column names of the 
POS_LOG_MASTER table.
Function numbers corresponding to receipt body are specified in the [BODY] section. Parameters 
corresponding to these functions should be column names of the POS_LOG_DETAIL table. 
Function numbers corresponding to receipt end are specified in the [EPILOG] section. Parameters 
corresponding to these functions should be column names of the POS_LOG_MASTER table.
Function numbers which should not display on the screen in text view. But data of these functions are saving 
to POS base – if they are specified in [PROLOG],[BODY],[EPILOG] sections (see. PROLOG,BODY,EPILOG ).
Parameters and output string are specified in the [PROLOG_EVENT_PARAM] section. The specified string is 
displayed if this parameter is in the received xml-package. This section is applied for systems without 
concrete determination of receipt entry.

Matches of sending parameters and column names of pos database tables depending on function number 
are specified in the [TRANSFORM] section.

In the above example, the item_total column will match to the received ItemPrice parameter if function 
number is not 5 or 6. If function number is 5 – the item_amount column, if function number if 6 –
 item_price column.
It's possible to send the following string:

instead of the string:

In this case, description in the [TRANSFORM] field is not required.
Matches of receiving function numbers (FunctionNumber) and their names are specified in the 
[FUNCTIONNAME] section. It's using for matching function numbers and their names in reports forming in 
accordance of operator search requests.
When parameter specified in the [IGNORE_ZERO] section equals zero, the corresponding POS event will be 
ignored. For example, package is received from the POS, and the following text is specified in the 
xml_titles.txt file, than section with the specified event won't be added to the POS_LOG_DETAIL table.
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1.

2.

3.

Package with zero IDCAmount parameter

Fragment of the xml_titles.txt file specifying on requirement to ignore the package
A system defines the way of adding parameter values to the database basing on functions specified in 
PROLOG,BODY,EPILOG sections. Parameters are adding only when function numbers in which the specified 
parameters are sending are added to one of three section (PROLOG,BODY,EPILOG).

Values are loading to the database as follows:

Record is adding to the [POS_LOG_MASTER] table using the INSERT SQL operation when receiving function 
specified in the [PROLOG] section. Program automatically increases a [check_id] counter and stores it.
Record is adding to the [POS_LOG_DETAIL] table using the INSERT SQL operation where the stored value of 
the [check_id] table is specified in the [id] field, when receiving function specified in the [BODY] section.
Record is updating in the [POS_LOG_MASTER] table using the UPDATE SQL operation for the string where 
the [check_id] value corresponds to the stored value, when receiving function specified in the [EPILOG]
section.
So the [check_id] field is using within the program and should not be in use as name of sending parameter.
Sequence order of sections can be optional. Single-line comments can be written using // symbols.
For example, the package is received when adding a good to receipt:

and the following description is corresponding to this package:
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In this case the following captions will be displayed: 

Record containing values of item_name, item_count, item_total fields and the FunctionNumber value will be 
added to the POS_LOG_DETAIL table of the pos database.

2.1.4 Interaction with POS server
Integration with POS server which can receive events from all pos terminals (or filling stations) and resend them to 
the video surveillance system using one logic connection is allowable.

The separate camera (cameras) should be added to the each POS (filling station).

In this case the StationNumber tag is required in the package.

Where ID − unique identifier of POS (filling station).

Example of interaction with POS server:

One POS is installed in the filling station and data are sending to the video surveillance system using this POS. 3 
filling stations are connected to this POS. The separate camera is added to the each filling station.

To realize video monitoring in the POS PSIM software it's required to create 3 POS-terminal objects in the objects 
tree, assign cameras to the each POS terminal object and assign POS terminal to the corresponding POS.

Then the POS will send data to the mixforward.exe utility embedded to the POS PSIM software which will analyze 
data and resend them to created system objects.

2.2 Configuring the POS PSIM system when working with XML data 
communication protocol

To configure the POS PSIM system when working with XML data communication protocol, do the following:
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1.

2.

Go to the settings panel of the POS terminal object.

Click the Advanced button (1).

Note.

The POS-terminal object is based on the Computer object on the Hardware tab of the System 
settings dialog window.


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3.

4.
5.

In the opened window select the XML protocol from the Supported POS terminals drop-down list (1).

Click OK (2) to save changes and return to the settings panel of the POS terminal object.
Click Apply (2) to save changes.

Configuring the POS PSIM system is completed.

2.3 Configuring xml_titles.txt settings file
To simplify configuring of the xml_titles.txt file use the specialized utility. The xml_test.exe utility is designed to 
debug captions above the video image when working with XML protocol of the POS-terminal module. The 
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xml_test.exe utility is a part of the POS SDK utilities and libraries package. To launch the utility, download the POS 
SDK archive, extract files and launch the POS_SDK\XML_Protocol\Xml_test.exe executable file.

The xml_text.exe utility contains three windows:

Note

If sending data are in DOS coding, it's required to launch the advanced settings utility tweaki.exe and set 
the Convert DOS to Windows codepages (2) checkbox in the POS (1) section.


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XML-log received from the POS is loaded to the first window. Logs are saving in the <Axxon PSIM software 
installation directory>\Modules\PosCapture folder. Name of log file is pos_N.log, where N is the number of POS-
terminal corresponding to POS from which log was received.

Ensure that the Save data to file checkbox (2) is set in the POS (1) section of the tweaki.exe utility if there are no 
logs in this file.
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To open log select File -> Open -> XML source menu.

The xml_titles.txt parser file replying for displaying is loaded to the second window. To open xml_titles.txt file 
select the File -> Open ->View config file menu.

Note

The AxxonSoft protocol log menu item is not in use.

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It's possible to load existed file or form it singly.

Displayed captions above the video image while POS PSIM working with connected devices will display in the third 
window when pressing the F7 key.

So the main operation is editing a content of the second window.

To save the xml_titles.txt file select the File -> Save -> View config file menu.

Then it's required to copy the file to the < Axxon PSIM software installation directory >\Modules\Pos\xml_titles.txt.
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2.4 Description of XML protocol packages for interaction with POS PSIM 
system

2.4.1 Fields and their values
List of fields and their values is given in the table. This list is recommended. Functions can be added or removed.

Function parameters, their names and number can be optionally changed except for the FunctionNumber
parameter (it's a required parameter).

Changing the functions or parameters will require configuring the xml_titles.txt file.

Field Value

FunctionNumber Number of a function

FunctionName Name of a function

cash_number Number of a POS

card_number Number of a card

date Date of a document creation

discount_name Name of a discount

enter_type Method of entering a payment card number:

1—using keyboard; 2—via magnetic reader; 3—using pin-
pad; 4—via barcode using a scanner

receipt_number Number of a receipt

item_id Item identifier

item_name Item name

item_barcode Item barcode

item_price Item price

item_quantity Quantity of items

item_discount Item discount
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item_amount Amount of items in a receipt

receipt_amount Current amount of a receipt

item_pos Number of an item

receipt_discount Total discount

receipt_discount_number Discount amount (%)

payment_name Name of payment instrument

payment_amount Total receipt amount

payment_amount_with_change Received amount from a customer

payment_change Amount of change

result Result of receipt completion: 1—cancelled receipt; 2—
delayed receipt

result_str Comment for receipt completion

shift_number Number of shift

TransactionTimestamp Event time specified in the yyyy-mm-ddThh:nn:ss.fff
format. The parameter must be specified in the UTC+0 
time zone

receipt_type Type of a receipt

restore Typr of receipt restoring

type_str Comment

type Type of an operation

user_name Name of a cashier

user_id Cashier ID
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1.

2.

3.

2.4.2 Format of data exchange packages with AxxonSoft video monitoring system
Cashier login

<TransactionBlock>
                <FunctionNumber>1</FunctionNumber>
<FunctionName>Cashier login</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Cashier logout

<TransactionBlock>
                <FunctionNumber>2</FunctionNumber>
<FunctionName>Cashier logout</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Add a position

<TransactionBlock>
                <FunctionNumber>3</FunctionNumber>
<FunctionName>Add a position</FunctionName>
                <receipt_number>10</receipt_number>
                <item_id>006946</item_id>

Note

In operations connected with receipts (7, 8, 11, 19), the <type> parameter can take the following values (if 
they are available):
0—receipt for sale;
1—return;
2—return by receipt;
5—restoring of a delayed receipt;
7—receipt for inventory;
8—receipt for non-tax purposes;
9—return by receipt for non-tax purposes.

The values of the <type> parameter in operation 15:
100—insertion;
101—subtraction.
The date and time should be in the YYYY-MM-DD HH:MM:SS.MS format, where YYYY—year, MM—month, DD
—day, HH—hour, MM—minutes, SS—seconds, MS—milliseconds. For example, 2006-09-01 13:13:34.045.


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4.

5.

6.

                <item_name>MILK 0.5L</item_name>
                <item_barcode></item_barcode>
                <item_price>10.00</item_price>
                <item_quantity>1.000</item_quantity>
                <item_amount>10.00</item_amount>
                <receipt_amount>0.00</receipt_amount>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Change quantity

<TransactionBlock>
                <FunctionNumber>4</FunctionNumber>
<FunctionName>Change quantity</FunctionName>
                <receipt_number>10</receipt_number>
                <item_id>013611</item_id>
                <item_name>MILK 0.5L</item_name>
                <item_barcode></item_barcode>
                <item_price>15.10</item_price>
                <item_quantity>5.000</item_quantity>
                <item_amount>75.50</item_amount>
                <receipt_amount>29.00</receipt_amount>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Cancellation and reversal of position

<TransactionBlock>
                <FunctionNumber>5</FunctionNumber>
<FunctionName>Cancellation and reversal of position</FunctionName>
                <receipt_number>10</receipt_number>
                <item_id>013611</item_id>
                <item_name>MILK 0.5L</item_name>
                <item_barcode></item_barcode>
<item_price>15.10</item_price>
                <item_quantity>5.000</item_quantity>
                <item_amount>75.50</item_amount>
                <receipt_amount>29.00</receipt_amount>
                <date>27.09.2006 15:42:19</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Change price of current position

<TransactionBlock>
                <FunctionNumber>6</FunctionNumber>
<FunctionName>Change price of current position</FunctionName>
                <receipt_number>10</receipt_number>
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7.

8.

9.

                <item_id>005393</item_id>
                <item_name>MILK 0.5L</item_name>
                <item_barcode></item_barcode>
                <item_price>29.00</item_price>
                <item_quantity>1.000</item_quantity>
                <item_amount>29.00</item_amount>
                <receipt_amount>0.00</receipt_amount>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Delayed or cancelled receipt

<TransactionBlock>
                <FunctionNumber>7</FunctionNumber>
<FunctionName>Delayed or cancelled receipt</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <date>2006-09-07 15:20:45.051</date>
                <receipt_number>283</receipt_number>
                < receipt_type>0</ receipt_type>
                <result>1</result>
                <result_str>RECEIPT CANCELLATION</result_str>
                <receipt_amount>240.00</receipt_amount>
                <receipt_discount>0.00</receipt_discount>
<receipt_discount_number>0</receipt_discount_number>
                <cash_number>9999999</cash_number>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Closing a receipt

<TransactionBlock>
                <FunctionNumber>8</FunctionNumber>
<FunctionName>Closing a receipt</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <date>2006-09-07 15:20:45.051</date>
                <receipt_number>280</receipt_number>
                <receipt_type>0</receipt_type>
                <result>0</result>
                <receipt_discount>0.00</receipt_discount>
<receipt_discount_number>0</receipt_discount_number>
                <receipt_amount>721.90</receipt_amount>
                <cash_number>9999999</cash_number>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Total amount



POS PSIM 1.0.1 (english) – POS SDK

XML-protocol– 23

10.

11.

12.

<TransactionBlock>
                <FunctionNumber>9</FunctionNumber>
<FunctionName>Total amount</FunctionName>
                <receipt_number>10</receipt_number>
                <receipt_amount>29.00</receipt_amount>
                <receipt_discount>0.00</receipt_discount>
<receipt_discount_number>0</receipt_discount_number>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Payment on receipt

<TransactionBlock>
                <FunctionNumber>10</FunctionNumber>
<FunctionName>Payment on receipt</FunctionName>
                <receipt_number>10</receipt_number>
                <payment_name>Cash</payment_name>
                <payment_amount>721.90</payment_amount>
                <payment_amount_with_change>800.00</payment_amount_with_change>
                <payment_change>78.10</payment_change>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Opening a receipt

<TransactionBlock>
                <FunctionNumber>11</FunctionNumber>
<FunctionName>Opening a receipt</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <date>2006-09-07 15:20:45.051</date>
                <receipt_number>285</receipt_number>
                <receipt_type>5</receipt_type>
                <type_str>RESTORING</type_str>
<restore>RESTORING AFTER FAILURE</restore>
                <cash_number>9999999</cash_number>
                <shift_number>5</shift_number>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Closing a shift

Note

Value of the receipt_type parameter shows that opening a receipt was after failure. Detailed 
information about values of this parameter, see in Fields and their values.


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13.

14.

15.

<TransactionBlock>
                <FunctionNumber>12</FunctionNumber>
<FunctionName>Closing a shift</FunctionName>
                <receipt_number>286</receipt_number>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Discount

<TransactionBlock>
                <FunctionNumber>13</FunctionNumber>
<FunctionName>Discount</FunctionName>
                <receipt_number>10</receipt_number>
                <discount_name>Hand_disk</discount_name>
                <receipt_amount>0.00</receipt_amount>
                <receipt_discount>0.00</receipt_discount>
<receipt_discount_number>0</receipt_discount_number>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Open a till

<TransactionBlock>
                <FunctionNumber>14</FunctionNumber>
<FunctionName>Open a till</FunctionName>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Monetary operation

<TransactionBlock>
                <FunctionNumber>15</FunctionNumber>
<FunctionName>Monetary operation</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <date>2006-09-07 15:20:45.051</date>
                <receipt_number>288</receipt_number>
                <type>101</type>
                <type_str>SUBTRACTION</type_str>
                <payment_name>Cash</payment_name>
                <payment_amount>16050.00</payment_amount>
                <shift_number>6</shift_number>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>
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Card for payment

<TransactionBlock>
                <FunctionNumber>16</FunctionNumber>
<FunctionName>Card for payment</FunctionName>
                <receipt_number>10</receipt_number>
                <enter_type>1</enter_type>
                <card_number>4895</card_number>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Discount card

<TransactionBlock>
                <FunctionNumber>17</FunctionNumber>
<FunctionName>Discount card</FunctionName>
                <receipt_number>10</receipt_number>
                <enter_type>1</enter_type>
                <card_number>2367</card_number>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Manual discount

<TransactionBlock>
                <FunctionNumber>18</FunctionNumber>
<FunctionName>Manual discount</FunctionName>
                <receipt_number>10</receipt_number>
                <type_str>DISCOUNT FOR ITEM</type_str>
                <item_pos>1</item_pos>
                <item_discount>-15</item_discount>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Print a receipt copy

<TransactionBlock>
                <FunctionNumber>19</FunctionNumber>
<FunctionName>Print a receipt copy</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>

Note

Value of the type parameter shows the case of subtraction money. It's possible to insert money, 
see Fields and their values.


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                <date>2006-09-07 15:20:45.051</date>
                <receipt_number>291</receipt_number>
                <receipt_type>0</receipt_type>
                <type_str>SALE</type_str>
                <cash_number>9999999</cash_number>
                <shift_number>6</shift_number>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Opening a till without transaction

<TransactionBlock>
                <FunctionNumber>20</FunctionNumber>
<FunctionName>Opening a till without transaction</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Z-report

<TransactionBlock>
                <FunctionNumber>21</FunctionNumber>
<FunctionName>Z - report</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <shift_number>5</shift_number>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

X-report

<TransactionBlock>
                <FunctionNumber>22</FunctionNumber>
<FunctionName>X - report</FunctionName>
                <user_name>Smith</user_name>
                <user_id>19</user_id>
                <shift_number>6</shift_number>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Control package

<TransactionBlock>
<FunctionNumber>77777</FunctionNumber>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
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</TransactionBlock>

Manual input

<TransactionBlock>
<FunctionNumber>23</FunctionNumber>
<FunctionName>Manual input</FunctionName>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>

Attempt of forbidden operation

<TransactionBlock>
<FunctionNumber>25</FunctionNumber>
<FunctionName>Attempt of forbidden operation</FunctionName>
<type_str>Operation name</type_str>
                <date>2006-09-07 15:20:45.051</date>
<TransactionTimestamp>2009-01-01T04:04:33.004</TransactionTimestamp>
</TransactionBlock>
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3 Using a .prl parser

3.1 General information about creating .prl parsers in the POS PSIM 
software

Parsers with .prl file extension define the rules of loading receipts database if data from the POS-terminal are 
sending to the POS-server by protocol differing from XML. Regular expressions are used when parser creating.

To create parser, do the following:

Create templates using parser_designer.exe and ParserTest.exe utilities.
Add created templates to the parser using the POS PSIM software.

3.2 Regular expressions

3.2.1 General information about regular expressions
To analyze POS operations it's required to review data flow received from pos terminal and select the required 
data. Regular expressions are used for this purpose.

Regular expressions - template languages.

Template is processed symbol-by-symbol. For example, to find a "d" letter in the "stadium" word, it's required to 
analyze all letters of the "stadium" word and estimate them with required letter.

Template – is a unique indicator what to search in the string. It's possible to search digits, letters, invisible symbols 
(space, tabbing, etc.).

To search the "d" or "m" letter in the "stadium" word unless the first coincidence, use the method of sorting: 
analyze each letter and compare it with the required symbol. i.e. with "d" and "m". Such set of search conditions is 
called a symbol sorting and it's writing as follows: [dm] - it says that d or m letters are searching for.

To specify that any letter is searching for, it's required to list them all [abc...xys] or specify the interval [a-z].

To get the symbol sorting with all Latin letters specify the [a-zA-Z] in a template.

This symbol sorting describes only one symbol. To describe all symbols in the string use quantifiers.

3.2.2 Quantifiers
For example, there are two strings:

abcd12345efg 
fghi56789qwe

Note.

There are a lot of ways of recording templates to the same fragment. So examples given in this section are 
not the only possible.



Note.

The following description of regular expressions based on text from the  https://en.wikipedia.org/wiki/
Regular_expression web-site.



https://en.wikipedia.org/wiki/Regular_expression
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Condition: Find parts in strings which contain four latin letters and then 5 digits.

How to describe a symbol coincident with some Latin letter (a symbol sorting is in user for it: [a-z] (don't pay 
attention to capitals)), and a symbol of coincident with a digit: [0-9] was described in the previous section.

It's required to find strings with four letters at first and 5 digits straight after them.

It's allowable to write: [a-z][a-z][a-z][a-z][0-9][0-9][0-9][0-9][0-9] 

Such form of search condition will work. One symbol of search condition is described by symbol sorting. Such 
construction is too massive. It's recommended to use quantifiers in such cases. Quantifier determines number of 
symbols in a search condition. So the search condition will be simplified be quantifiers: [a-z]{4}[0-9]{5}

Number of symbols described in symbol sorting and going one after another in a string is specified in curved 
brackets.

So 5 digits are going after 4 Latin letters. Each symbol sorting described only one symbol, number of similar 
sequential symbols are described by quantifiers.

This specifying of symbol numbers in a search condition is not unique. Quantifiers can be different: [a-z]{1,3} means 
that from one to three Latin letters can go one after another. [a-z]{2,} means that minimum two Latin letters can go 
one after another.

Quantifier in curved brackets is not unique way to set number of symbols going one after another. [a-z]* means that 
any number of Latin letters can go one after another, like [a-z]{0,}. [a-z]+ means that at least one Latin letter can go 
one after another, but maximal number is not specified, like [a-z]{1,}. [a-z]? means that number of Latin letters is not 
more than 1, letter also can be missed, like [a-z]{0,1}.

Condition search of similarities which is described by nonspecial symbol is a literal.

Some of quantifiers given above can be applied to literals. 

If the abcd{1,4}efg condition search will be applied for abcefg string, the similarities won't be found because a 
quantifier {1,4} means that from one to four digits "d" will be after abc and before efg.

3.2.3 Symbol sorting
Symbol sorting can contain some literal or literal intervals. To describe literal intervals the '-' symbol is used which 
is staying between the first and last symbol in an interval. Examples of different intervals of one symbol sorting are 
as follows: [1-5] - digits from 1 to 5, [a-f] - Latin letters from a to f, [a-fq-x] - Latin letters from a to f and from q to x, 
two ranges are in use in the last symbol sorting. 

If some of symbols: a or g or 7 or 4 can be in the determined positions, than the symbol sorting will be as follows: 
[ag47].

 It's possible to specify allowable literals in a symbol sorting. Specifying of literals can be combined with specifying 
intervals: [14a-kz] means that a symbol in a string can be similar with 1, 4, Latin letters from a to k and with z letter. 
Letters, digits, punctuation marks, mathematical signs can be a literal. For example, ',' (coma), '!' (exclamation 
point), '+' (plus). It's possible to use '-' (minus) symbol even if it used for interval specifying. If specify '-' between a 
and z, it will be interval, but if specify it after opened square bracket - it will be minus. For example, [-,a-z] means 
that symbol sorting contain minus, coma and Latin letters from a to z.

To specify symbol sorting containing all symbols except of the specified, e.g. all symbols except of a,b,c, use the 
special negation symbol: ^ (cover). It's required to specify: [^abc] - all symbols (not letters, but symbols) except of 
a,b,c Latin letters.

It's possible to train to write templates here.

https://regex101.com/
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3.2.4 Special symbols
To specify, for example, space in a search condition, it's required to make it visible, i.e. enter some symbol or set of 
symbols which will be identified as invisible.

\s - letter s after the backslash describe space or tabulation character. Space also can be specified the general way, 
but [a-z\s] template will be more clear than [a-z ]. Use this symbols carefully because it's the same as space, 
tabulation and a symbol of new string.

\S - visible symbols. i.e. all symbols which are not coincide with \s

\w - special symbol exchanging the whole symbol sorting and containing all symbols which can be specified in a 
word, mostly it is [a-zA-Z_], but it depends on installed localization, Unicode supporting, etc.

\W - all symbols which are not coincide with \w or [^a-zA-A_]

\d - all digits, i.e. [0-9]

\D - non-digit symbols

Often special symbols describe commonly used character sets, but these sets have boundaries, i.e. digits, letters 
and underlining or invisible symbols. To describe all symbols use a point. For example,

.{5} - five different symbols.

To describe a point, set the backslash before it: \.

To search a backslash after which a point is going, enter the double slash as literal in a search condition:

Similarly, to enter two backslashes, it's required to double them: \\\\

3.2.5 Select condition
It's possible to create a search condition using regular expressions. For example, there are two groups of literals: 
one of them contain two literals b and e going one after another, the other group contain nine literals going one 
after another: n, o, t, \s, t, o,\s, b, e.

\s is a space. Group of literals - is a sequence of symbols describing by symbol sorting or by literals. Group of literals 
is presenting in a brackets. They also save registered group of literals to special variables.

Examples of literal groups are follows:

(be)
(not\sto\sbe)

Select from two literal groups: (be)|(not\sto\sbe), "|" symbol between literals is a selection condition "or". Regular 
expression of checking:

(be)|(not\sto\sbe)

Regular expression is a similar if:

string is not equal "be"
or if string is not equal "not to be"

It's possible to select between literals and between groups of literals. Literal groups are combining in brackets. If it's 
required to select between two single literals, than two literals between there is a vertical line are to be combined in 
brackets.

Example of selection from two literals: s(o|u)n is son and sun.

Example of selection from two literal groups: (son)|(sun) is also son and sun.

In case of selection between single literals or between literal groups, literals are to be combined in brackets.
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a.

b.

1.

To enter "|" literal, it's require to enter a special symbol behind it which will mean that vertical line is a literal. This 
special symbol is a backslash: \|

3.3 Description of the parser_designer.exe utility interface
View of the parser_designer.exe utility window is shown in the figure.

Areas designed for the following functions are located in working area of the utility:

Select folder with log from a POS-terminal (1).
Select log (2).
Display log text (3).

The Select filter drop-down list is for protocol selection.
The Dos to windows checkbox is for recoding symbols if log text is in the DOS coding.
Default font and Taiwan font buttons are for selecting fonts.

Templates of regular expressions.
List of table fields selected in the Table field from the connected database (5). POS_LOG_MASTER and 
POS_LOG_DETAIL tables are used.

The POS_LOG_MASTER table stores data about title and end receipt part: receipt number, name and 
code of cashier, total sum, exchange sum, etc.
The POS_LOG_DETAIL table stores data of receipt "body", i.e. information about good from this 
receipt. 

Utility main menu allows access to the following functions:

Load database – settings of connection to POS database (6).
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7.

Supported POS - displaying list of supported POS-terminals in the current utility version (7).

3.4 Creating a parser
To create a parser, do the following:

Select the required text fragment in the window of log text. In the window 5 select a field in a table in which 
text fragment is to be written. Click the left mouse button and replace field to window with log text.
In the opened window select a format of template. The following formats are available:

. - some symbol
[%number%] - only digits and decimal point
[%char%] - digits and symbols

Select type of length. The following types of length are available:
No length - not limited length
Fixed length - fix length which is counting automatically by the selected fragment.

String in the log field takes a form of a template with specifying a field name. Construction like ?
P<item_name> specified a table field to which the recognized value will be loaded - e.g. it's a check_number 
field. If required. it's possible to change the regular expression going after this text.

Create templates for all required fields of database the similar way.

Note.

For correct connection to the POS database use Windows authorization because functionality of 
password saving when connecting to database using login and password was disabled at the 
moment of writing this documentation.


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For example, a template for cashier name is shown in the figure (length is not limited).

Selected fragment is a template of title receipt part.

3.5 Checking a created template
To check working of the created template use the ParserTest.exe utility.

Note.

Data from body receipt part are saving in the table different from table in which data from title and end 
parts are saving. So before creating a parser select the corresponding table from the Table drop-down list.


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Template is checked as follows:

Copy fragment of parser to the Templates field.
Put fragment of receipt text to the Data field.
Click the Check button.
If template is correct, than names of fields which will be loaded to database and their values will display in 
the Result field. Otherwise, the template is failed.

If data in the Result field are correct, replace template to parser settings of the POS-terminal object using 
functions of copying and pasting text (see Configuring parser in the POS PSIM software).

Note

Unnecessary spaces in begin of strings, signs of string end, etc. can be errors. Template from 
example in the figure:
«(?P<check_id>[%number%]{6})      pos 06 »
from the figure in the Creating a parser section is transformed the following way:
«(?P<check_id>[%number%]{6})\s*pos 06».
Spaces are changed to "\s" to avoid errors of spaces number.



Note

For examples from figures, replace the template to the Receipt prolog section. Other receipt sections are 
adding in the same way.


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3.6 Configuring parser in the POS PSIM software

When templates for all needed fields are created and checked, it's required to create a parser file. Do the following:

Run POS PSIM. Go to the Hardware tab of the System settings dialog window and select the required POS-
terminal object for which parser is configuring. Click the Advanced button on the settings panel of this 
object.
In the opened window go to the Parser settings tab.
Configure prolog/end/body of receipt:

Using the + button add a rule of structuring.
Copy test of structuring rule formed using the parser_designer.exe utility and checked using the 
ParserTest.exe utility.
Repeat steps 3.a-3.b for all required structuring rules of prolog/end/body of receipt.

Specify name of a parser in the Template name field.
Click the Export button to save parser as file with .prl resolution.

Attention!

To get the possibility of templates editing, run the tweaki.exe utility, go to the POS section (1) and set the 
Allow to specify recognition settings checkbox (2).



Note
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Detailed process of parser creation is given in the POS PSIM software package. Administrator's Guide, 
section Using a .prl parser.
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4 Libraries for working with POS PSIM software package

4.1 COM. Library for working with TCP/IP connection
The library is designed for integration of POS software (working on Windows) with the POS PSIM system. It hides 
code of providing TCP/IP communication from programmers. For example, it's possible to resend data to network 
using TCP/IP protocol by some modifications of program code if there is code of data sending to receipt printer. 
Library provides COM object which is possible to use from some space supporting COM technology (e.g. Visual 
Basic, Delphi, 1S).

Application (for VB.NET):

Create object:

   Dim pos As Object

    pos = CreateObject("Poslib.Net")

 Start process of connection setup:

    Dim port As System.UInt32

    port = Convert.ToUInt32("5000")

    pos.Open(ip, port)

 Used method:

    HRESULT Open(BSTR ip_address,DWORD port) - is called at the beginning of working with library, initiates 
connection setup

ip_address – server address
port – connection port

Send text:

   pos.Send("Test!" & vbNewLine)

Used method:

   HRESULT Send(BSTR str);

- str – sending message to system

Close connection:

    pos.Close()

Used method:

HRESULT Close() – is called at the end of working with library

Attention!

Libraries from the POS SDK package are given as example. AxxonSoft company is not responsible for their 
operation.



Attention!

It's required to register the regsvr32.exe poslib.dll library previously.

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When calling the Open method, the library is connecting using TCP/IP and restoring connection if it was lost. All 
callings are asynchronous and they don't have an impact to the main flow. Data are sending from a separate flow. 
All used methods are thread-safe.

 When calling the Send method, data will be send if connection established and won't be send if connection lost. 
There is no any confirmation of successful/failed data sending.
It's required to specify type of TCP/IP connection and enter a port number specified as method of Open function on 
the settings panel of the POS terminal object of the POS PSIM system.

4.2 ActiveX component for working with TCP/IP connection
The library is designed for integration of POS software (working on Windows OS) with the POS PSIM system. It hides 
code of providing TCP/IP communication from programmers. For example, it's possible to resend data to network 
using TCP/IP protocol by some modifications of program code if there is code of data sending to receipt printer. 
Library provides ActiveX component which is possible to use from some space supporting ActiveX technology (e.g. 
Visual Basic, Delphi, 1S).

Used methods:

Open(BSTR ip_address,DWORD port) - is called at the beginning of working with library, initiates connection 
setup

 ip_address – server address
 port – connection port

Send(BSTR str);
 str – sending message to system

Close() - is called at the end of working with library

When calling the Open method, the library is connecting using TCP/IP and restoring connection if it was lost. All 
callings are asynchronous and they don't have an impact to the main flow. Data are sending from a separate flow. 
All used methods are thread-safe.

 When calling the Send method, data will be send if connection established and won't be send if connection lost. 
There is no any confirmation of successful/failed data sending.
It's required to specify type of TCP/IP connection and enter a port number specified as method of Open function on 
the settings panel of the POS terminal object of the POS PSIM system.

4.3 DLL. Library for working with TCP/IP connection
The library is designed for integration of POS software (working on Windows) with the POS PSIM system. It hides 
code of providing TCP/IP communication from programmers. For example, it's possible to resend data to network 
using TCP/IP protocol by some modifications of program code if there is code of data sending to receipt printer.

Library functions:

 void __stdcall Open (LPCTSTR id,LPCTSTR ip_address,DWORD port) – is called at the beginning of 
working with library, initiates connection setup

ip_address – server address
port – connection port

 void __stdcall Close (LPCTSTR id) – is called at the end of working with library
 void __stdcall Send(LPCTSTR id,LPCTSTR str)

Attention!

It's required to register the regsvr32.exe posx.ocx library previously.

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• str – sending message to system.

General parameter LPCTSTR id for all functions is a connection identifier. It's allowable to have several connections 
with different servers recognizing them by this identifier.

When calling the Open method, the library is connecting using TCP/IP and restoring connection if it was lost. All 
callings are asynchronous and they don't have an impact to the main flow. Data are sending from a separate flow. 
All used methods are thread-safe.

 When calling the Send method, data will be send if connection established and won't be send if connection lost. 
There is no any confirmation of successful/failed data sending.

 It's required to specify type of TCP/IP connection and enter a port number specified as method of Open function on 
the settings panel of the POS terminal object of the POS PSIM system.
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5 Interaction with 1S program
POS SDK package contains example of the 1S program enabling sending messages to the POS PSIM system.
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6 Appendix 1. The tpcgen.exe utility for sending text data to the 
POS PSIM system

6.1 General information about the tcpgen.exe utility
The tcpgen.exe utility allows sending log from the pos-terminal to the POS PSIM software package to check 
operation of the configured POS terminal object.

Interface of the tcpgen.exe utility is shown in the figure,

Sending data will be processed by the POS PSIM system in operation mode: video titling, data recording to 
database, etc.

6.2 Working with the tcpgen.exe utility
Working with the tcpgen.exe utility is performed as follows:

Note.

Download the utility as part of the POS SDK here.




POS PSIM 1.0.1 (english) – POS SDK

Appendix 1. The tpcgen.exe utility for sending text data to the POS PSIM system– 42

1.

2.

3.

4.

5.

6.
7.
8.
9.

Run the tcpgen.exe utility.

From the Protocol drop-down list select the connection protocol on which data will send to the POS PSIM
(1). TCP/IP, UDP and RS232 protocols are available.
Configure connection parameters if default parameters are not valid (2). IP-address and port of connection 
to the POS PSIM are specified when using the TCP/IP and UDP protocols, number and speed of port are 
specified when using the RS232 protocol.
Click the Open button and select a text file with pos-terminal log using the Windows standard dialog of files 
opening (3).
To stop data sending to the POS PSIM when log file will end, set the Stop send if end of file checkbox (4). To 
send data cyclically, keep the checkbox deselected.
Specify the required delay between packages in milliseconds in the Delay field (5).
Specify the package length in bytes in the Length field 96).
Click the Connect button (7).
Process of sending will display in the status field (8). If data sending is impossible, description of problem 
will be specified in the field.

Working with the tcpge.exe is completed.

Note.

To stop data sending click the Disconnect button.

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